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PowerQuest® Server Image™ License Agreement

IMPORTANT: Read this before using your copy of PowerQuest Server Image.

This document is a legal agreement between you (an individual or business), the Licensee, and PowerQuest Corporation. Use 
of the enclosed software indicates your acceptance of these terms. As used in this License Agreement, the term “Software” 
means the software included on the CD or disk media provided with this License Agreement. The term “Software” does not 
include any software that is covered by a separate license offered or granted by a person other than PowerQuest Corporation.

IF YOU DO NOT AGREE TO THESE TERMS AND CONDITIONS, EITHER DESTROY OR RETURN, INTACT, THE 
SOFTWARE PACKAGE, CONTAINING THE CD OR DISK MEDIA, TOGETHER WITH THE OTHER COMPONENTS OF THE 
PRODUCT TO THE PLACE OF PURCHASE FOR A REFUND OF THE PURCHASE PRICE.

I. PROPRIETARY RIGHTS. The SOFTWARE and any accompanying documentation are the proprietary products of 
PowerQuest Corporation (PowerQuest) or its licensors and are protected under national laws and international treaty 
provisions. Ownership of the SOFTWARE and all copies, modifications, translations, and merged portions thereof shall at all 
times remain with PowerQuest or its licensors

II. GRANT OF LICENSE and TERM. The SOFTWARE and accompanying documentation are being licensed to you, which 
means you have the right to use the SOFTWARE only in accordance with this License Agreement. The SOFTWARE is 
considered in use on a computer when it is loaded into temporary memory or installed into permanent memory.

PERSONAL LICENSE. This license is personal to you. You may not sublicense, lease, sell, or otherwise transfer the 
SOFTWARE or any of the accompanying documentation to any other person. You may use the SOFTWARE only for your 
own personal use if you are an individual, or for your own internal business purposes if you are a business. If you are a 
service bureau, integrator, value added reseller, or other type of service provider and wish to use this software on your 
clients’ computers, you must use one of PowerQuest’s VAR Licenses. For more information on PowerQuest’s VAR Licenses, 
call PowerQuest’s sales office at 801-437-8900 or 1-800-379-2566.

SERVER-SPECIFIC LICENSE. Each permitted copy of the SOFTWARE may be used only in connection with one network server 
owned or leased by you. Once a copy of the SOFTWARE has been used on a server, it may not be used on any other server. 
If the SOFTWARE is made available on a network, it may be accessed only by ONE specific computer. Once the SOFTWARE 
has been accessed by ONE specific computer, it may not be used on any additional computers without purchasing additional 
licenses.

NUMBER OF COPIES LICENSED. You are authorized to use ONLY a single copy of the SOFTWARE on the number of 
server(s) for which you have purchased a license as indicated on the accompanying license certificate. In addition to any 
copies authorized under this license agreement, you may make a single copy of the SOFTWARE solely for backup purposes. 
All copies of the SOFTWARE must include the copyright, trademark, and patent notices. To purchase a multiple computer 
LICENSE, contact PowerQuest at 1-800-379 2566 or sales@powerquest.com.

TERM. This license is effective from your date of purchase and shall remain in force until terminated. You may terminate the 
license and this License Agreement at any time by destroying the SOFTWARE and the accompanying documentation, 
together with all copies in any form.

III. BACKUP COPY. Only ONE copy of the SOFTWARE may be created for archival or backup purposes.

IV. NONPERMITTED USES. Without the express prior written permission of PowerQuest, you may not (a) use, copy, modify, 
alter or transfer, electronically or otherwise, the SOFTWARE or documentation except as expressly permitted in this License 
Agreement, or (b) translate, reverse program, disassemble, decompile, or otherwise reverse engineer the SOFTWARE.

V. EXPORT CONTROLS. Certain uses of the SOFTWARE by you may be subject to restrictions under U.S. regulations relating 
to exports and ultimate end uses of computer software. You agree to fully comply with all applicable U.S. laws and 
regulations, including but not limited to the Export Administration Act of 1979 as amended from time to time and any 
regulations promulgated thereunder.

VI. U.S. GOVERNMENT RESTRICTED RIGHTS. If you are acquiring the SOFTWARE on behalf of any unit or agency of the 
United States Government, the following provision applies: It is acknowledged that the SOFTWARE and the documentation 
were developed at private expense and that no part is in the public domain and that the SOFTWARE and documentation are 
provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions as set forth 
in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or 
subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable. 
Contractor/Manufacturer is PowerQuest Corporation/P.O. Box 1911/Orem, UT 84059-1911/U.S.A.

VII. LIMITED WARRANTY. (a) PowerQuest warrants to you, the original end user, (i) that the SOFTWARE, other than 
third-party software, will perform substantially in accordance with the accompanying documentation and (ii) that the 
SOFTWARE is properly recorded on the disk media. This Limited Warranty extends for ninety (90) days from the date of 
purchase. PowerQuest does not warrant any third-party software that is provided with the SOFTWARE, but PowerQuest 
iii



  
agrees to pass on to you any warranties of the owner or licensor to the extent permitted by the owner or licensor. (b) This 
Limited Warranty does not apply to any SOFTWARE that has been altered, damaged, abused, mis-applied, or used other than 
in accordance with this license and any instructions included on the SOFTWARE and the accompanying documentation. (c) 
PowerQuest’s entire liability and your exclusive remedy under this Limited Warranty shall be the repair or replacement of 
any SOFTWARE that fails to conform to this Limited Warranty or, at PowerQuest’s option, return of the price paid for the 
SOFTWARE. PowerQuest shall have no liability under this Limited Warranty unless the SOFTWARE is returned to 
PowerQuest or its authorized representative, with a copy of your receipt, within the warranty period. Any replacement 
SOFTWARE will be warranted for the remainder of the original warranty period or 30 days, whichever is longer. (d) THIS 
WARRANTY IS IN LIEU OF AND EXCLUDES ALL OTHER WARRANTIES NOT EXPRESSLY SET FORTH HEREIN, WHETHER 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE, NON-INFRINGEMENT, OR WARRANTIES ARISING FROM USAGE OF TRADE OR COURSE OF 
DEALING. (e) THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS; YOU MAY HAVE OTHERS WHICH VARY FROM 
STATE TO STATE. (f) Your Failure to return the enclosed registration card may result in PowerQuest’s inability to provide you 
with updates to the SOFTWARE, and you assume the entire risk of performance and result in such an event.

VIII. LIMITATION OF LIABILITY. IN NO EVENT SHALL POWERQUEST’S LIABILITY RELATED TO ANY OF THE SOFTWARE 
EXCEED THE LICENSE FEES ACTUALLY PAID BY YOU FOR THE SOFTWARE. EXCEPT FOR A RETURN OF THE PURCHASE 
PRICE UNDER THE CIRCUMSTANCES PROVIDED UNDER THE LIMITED WARRANTY, NEITHER POWERQUEST NOR ITS 
SUPPLIERS SHALL IN ANY EVENT BE LIABLE FOR ANY DAMAGES WHATSOEVER ARISING OUT OF OR RELATED TO 
THE USE OF OR INABILITY TO USE THE SOFTWARE, INCLUDING BUT NOT LIMITED TO DIRECT, INDIRECT, SPECIAL, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES, AND DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS 
INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR OTHER PECUNIARY LOSS, EVEN IF POWERQUEST 
CORPORATION HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, WHETHER SUCH LIABILITY IS BASED 
ON CONTRACT, TORT, WARRANTY, OR ANY OTHER LEGAL OR EQUITABLE GROUNDS. BECAUSE SOME STATES DO 
NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE 
ABOVE LIMITATION MAY NOT APPLY TO YOU.

IX. This License Agreement constitutes the entire agreement between you and POWERQUEST pertaining to its subject matter. 
This License Agreement is governed by the laws of the State of Utah. Any litigation arising from this license will be pursued 
only in the state or federal courts located in the State of Utah. Even if part of the agreement is held invalid, the rest of the 
agreement is still valid, binding, and enforceable. The failure of either party to exercise a right does not waive future exercise 
of that right or other rights.

For further information: Should you have any questions concerning this Agreement, or if you desire to contact PowerQuest 
Corporation for any reason, please write: PowerQuest Corporation/P.O. Box 1911/Orem, UT 84059-1911/U.S.A.

© 1994-1999, PowerQuest Corporation. All rights reserved. U.S. Patents 5,675,769 and 5,706,472; other patents pending in 
the U.S.A. and elsewhere. PowerQuest is a registered trademark and Server Image is a trademark of PowerQuest Corporation.
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Read this before using your copy of PowerQuest® Server Image™.

PowerQuest Corporation International Software License Agreement.

This Server Image License Agreement (“License”) is a legal agreement between you, the “End User,” and PowerQuest 
Corporation (“PowerQuest”). Use of the enclosed software indicates the End User  acceptance of these terms. As used in this 
License, the term “SOFTWARE” means the Server Image software included on the CD or disk media provided with this 
License. The term “SOFTWARE” does not include any software that is covered by a separate license offered or granted by a 
person other than PowerQuest, and this License does not grant any rights in such software.

IF THE END USER DOES NOT AGREE TO THESE TERMS AND CONDITIONS, THE END USER MUST EITHER DESTROY OR 
RETURN, INTACT, THE SOFTWARE PACKAGE, CONTAINING THE CDs OR DISK MEDIA, TOGETHER WITH THE OTHER 
COMPONENTS OF THE PRODUCT TO THE PLACE OF PURCHASE.

1. PROPRIETARY RIGHTS. The Software and any associated documentation are proprietary products of PowerQuest or its 
licensors and are protected under U.S. and European copyright, trademark, patent, and trade secret laws and international 
treaty provisions. Sole ownership of the SOFTWARE and all copies, modifications, and merged portions thereof shall at all 
times remain with PowerQuest or its licensors.

2. GRANT OF LICENSE. PowerQuest hereby grants to the End User a non-exclusive, non-transferable license to use the 
SOFTWARE in accordance with the terms of this License. The SOFTWARE is considered in use on a computer when it is 
loaded into temporary memory or installed into permanent memory.

3. COMPUTER-SPECIFIC LICENSE. Each permitted copy of the SOFTWARE may be used only in connection with a hard 
drive(s) that is (are) permanently connected to ONE specific computer (either a stand-alone computer or a computer 
connected to a network) owned or leased by the End User. Once a copy of the SOFTWARE has been used on a computer, it 
may not be used on any other computer, unless the End User has permanently stopped using (e.g., sold, destroyed, or 
relinquished possession of) the computer on which the SOFTWARE was first installed and has removed the SOFTWARE from 
the original computer. If the SOFTWARE is made available on a network, it may be accessed only by ONE specific computer. 
Once the SOFTWARE has been accessed by ONE specific computer, it may not be used on any additional computers without 
purchasing additional licenses.

5. CONFIDENTIALITY AND CONTROL OF THE SOFTWARE. The SOFTWARE, all associated documentation, and all copies 
are secret and confidential to PowerQuest and shall be retained under the effective control of the End User during the period 
of this License. The End User shall take all measures necessary to preserve confidentiality and secrecy in the SOFTWARE 
during the period of this license and after its termination, however such termination may arise.

6. PERSONAL LICENSE. This License is personal (including with respect to corporate entities) to the End User and the End 
User shall not assign or transfer any interest in it or grant any right under it to any third party or seek to exercise this License 
for the benefit or on the data of any third party.

7. UPDATES AND SUPPORT. The End User is entitled to receive 45-days technical support from the date of purchase. 
Technical support shall be limited to telephone or e-mail support from PowerQuest's offices, unless PowerQuest specifically 
agrees otherwise. The End User is entitled to receive SOFTWARE updates (updates are only version number changes to the 
right side of the decimal) in accordance with PowerQuest policies as announced from time to time on terms comparable to 
those offered to other users of the SOFTWARE under the Server Image Licenses.

8. INTEGRITY OF THE SOFTWARE. The End User shall not enhance or vary any part of the SOFTWARE nor procure or 
permit the whole or any part of the SOFTWARE (whether in its original or in any updated, enhanced or varied form) to be 
incorporated into any other software or computer system. Translations, reverse programming, disassembling, and reverse 
engineering of the SOFTWARE are expressly prohibited. Provided, however, that nothing in these conditions shall restrict (i) 
decompilations, notwithstanding that decompilation may involve adaptation, if the sole purpose of such decompilation is to 
achieve the interoperability of an independently created program with other programs, or (ii) any other act permitted to the 
End User by applicable laws and regulations of the End User's jurisdiction.

9. TERM AND TERMINATION. (a) This License is effective from the date of purchase of the SOFTWARE and shall remain in 
force until terminated. The End User may terminate this License at any time by destroying the SOFTWARE and its associated 
documentation, together with all copies in any form. (b) Notwithstanding 9(a) above, this License may be terminated at any 
time by written notice of termination given by PowerQuest to the End User in any of the following circumstances: (i) If the 
End User shall expressly or implied by repudiate this License by refusing or threatening to refuse to observe any of the 
conditions to which this License is subject; or (ii) If the End User shall fail to make any payment due under and pursuant to 
this License or to observe any of the conditions to which this License is subject and, after the End User's attention has been 
drawn by notice to such failure, shall fail to remedy the matter to PowerQuest's reasonable satisfaction within thirty days of 
the giving of such notice; or (iii) If the End User shall have a receiver or administrative receiver or administrator appointed or 
shall enter into liquidation whether compulsory or voluntary or if the End User shall be unable to pay its debts as and when 
they fall due. (c) On expiry, surrender or other termination of this License, however such termination may arise, the End User 
shall cease to load, store, copy, or use the Software and the associated documentation, shall delete the SOFTWARE from its 
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computers and shall either surrender the SOFTWARE and the associated documentation, together with all copies in any form, 
to PowerQuest or shall destroy the same. The End User shall continue after termination to observe and enforce confidentiality 
and secrecy in respect of the SOFTWARE and its associated documentation for the benefit of PowerQuest, and however 
termination may occur, it shall not prejudice any right of action or remedy which may have occurred prior to termination.

10. EXPORT CONTROLS. Certain uses of the SOFTWARE by the End User may be subject to restrictions under U.S. 
regulations relating to exports and ultimate end uses of computer software. The End User agrees to fully comply with all 
applicable U.S. laws and regulations, including but not limited to the Export Administration Act of 1979 as amended from 
time to time and any regulations promulgated thereunder.

11. LIMITED WARRANTY. (a) PowerQuest warrants to the End User, (i) that the SOFTWARE (not including any third-party 
software) will perform substantially in accordance with the associated documentation and (ii) that the SOFTWARE is properly 
recorded on the disk media. This Limited Warranty extends for ninety (90) days from the date of purchase. PowerQuest does 
not warrant any third-party software that is provided with the SOFTWARE, but PowerQuest agrees to pass on to the End User 
any warranties of the owner or licensor to the extent permitted by the owner or licensor. (b) This Limited Warranty does not 
apply to any SOFTWARE that has been altered, damaged, abused, mis-applied, or used other than in accordance with this 
License and any instructions included on the SOFTWARE and the associated documentation. (c) PowerQuest's entire liability 
under this Limited Warranty shall be the repair or replacement of any SOFTWARE. PowerQuest shall have no liability under 
this Limited Warranty unless the SOFTWARE is returned to PowerQuest or its authorized representative, with a copy of the 
End User's receipt, within the warranty period. Any replacement SOFTWARE will be warranted for the remainder of the 
original warranty period or 30 days, whichever is longer. (d) THIS WARRANTY IS IN LIEU OF AND EXCLUDES ALL OTHER 
WARRANTIES NOT EXPRESSLY SET FORTH HEREIN, WHETHER EXPRESS OR IMPLIED, SUBJECT TO CONTRARY ORDER 
PUBLIC REQUIREMENTS IN THE END USER'S JURISDICTION.

12. INDEMNITIES AND LIMITATION OF LIABILITY. (a) Subject to 12(b) below, PowerQuest warrants to the End User that 
the Software as supplied by PowerQuest will not infringe any copyright, patent, or other intellectual property right of any 
third party. Conditionally upon the End User's promptly giving notice to PowerQuest of any claim of alleged infringement 
and allowing PowerQuest to have sole control of negotiations on, and any defense of the claim, PowerQuest shall in its 
discretion and at its own cost either compromise or defend the claim and shall hold the End User harmless from any resulting 
final judgment, order or settlement. PowerQuest shall have the right to replace or change the SOFTWARE so as to avoid 
infringement and require the End User to accept a license to use such replaced or changed SOFTWARE in substitution for this 
License, provided that the SOFTWARE as substituted is substantially suitable for the End User's utilization. (b) PowerQuest's 
maximum liability to the End User under 12(a) above shall not exceed the License fees actually paid by the End User for the 
SOFTWARE. If PowerQuest becomes aware of a potential claim under 12(a) above, PowerQuest shall be entitled then or at 
any time thereafter to discharge its liabilities (including potential, accruing, and accrued liabilities) to the End User under 
12(a) above by requiring the End User to surrender this License and to cease use of the SOFTWARE upon PowerQuest's 
paying to the End User a sum equivalent to the maximum amount of PowerQuest's liability as stated above. (c) GENERAL 
LIMITATION OF LIABILITY AND INDEMNITIES. POWERQUEST'S MAXIMUM LIABILITY RELATED TO ANY OF THE 
SOFTWARE SHALL NOT EXCEED THE LICENSE FEES ACTUALLY PAID BY THE END USER FOR THE SOFTWARE. 

FOR AUSTRIA, BELGIUM, CZECH REPUBLIC, FRANCE, HUNGARY, IRELAND, LUXEMBOURG, AND THE NETHERLANDS:  
IN NO EVENT SHALL POWERQUEST BE LIABLE TO THE END USER, EXCEPT IN RESPECT OF (a) DEATH, PERSONAL 
INJURY OR DAMAGE TO PROPERTY CAUSED BY POWERQUEST'S NEGLIGENCE OR (b) POWERQUEST'S GROSS 
NEGLIGENCE OR WILLFUL MISCONDUCT, FOR AN AMOUNT IN EXCESS OF THE MAXIMUM AMOUNT OF 
POWERQUEST'S LIABILITY AS STATED IN 12(b) ABOVE, BY REASON OF ANY REPRESENTATION OR IMPLIED 
WARRANTY, CONDITION OR OTHER TERM OR ANY DUTY AT LAW, OR UNDER THE TERMS OF THIS AGREEMENT, 
FOR ANY CONSEQUENTIAL LOSS OR DAMAGE (WHETHER FOR LOSS OF PROFIT, BUSINESS INTERRUPTION, LOSS OF 
BUSINESS INFORMATION OR OTHERWISE) ARISING OUT OF OR IN CONNECTION WITH ANY ACT OR OMISSION OF 
POWERQUEST RELATING TO THE USE OR INABILITY TO USE THE SOFTWARE BY THE END USER. 

FOR GREECE: IN NO EVENT SHALL POWERQUEST BE LIABLE TO THE END USER, EXCEPT IN RESPECT OF DEATH, 
DAMAGE TO PROPERTY OR PERSONAL INJURY CAUSED BY POWERQUEST'S FRAUD OR GROSS NEGLIGENCE , FOR 
AN AMOUNT IN EXCESS OF THE MAXIMUM AMOUNT OF POWERQUEST'S LIABILITY AS STATED IN 12(b) ABOVE, BY 
REASON OF ANY REPRESENTATION OR IMPLIED WARRANTY, CONDITION OR OTHER TERM OR ANY DUTY AT LAW, 
OR UNDER THE TERMS OF THIS AGREEMENT, FOR ANY CONSEQUENTIAL LOSS OR DAMAGE (WHETHER FOR LOSS 
OF PROFIT, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION OR OTHERWISE) ARISING OUT OF OR IN 
CONNECTION WITH ANY ACT OR OMISSION OF POWERQUEST RELATING TO THE USE OR INABILITY TO USE THE 
SOFTWARE BY THE END USER. 

FOR ITALY: IN NO EVENT SHALL POWERQUEST BE LIABLE TO THE END USER, EXCEPT IN RESPECT OF DEATH, 
DAMAGE TO PROPERTY OR PERSONAL INJURY CAUSED BY POWERQUEST'S FRAUD OR GROSS NEGLIGENCE OR 
VIOLATION OF A DUTY ARISING FROM APPLICABLE ORDINE PUBBLICO RULES , FOR AN AMOUNT IN EXCESS OF THE 
MAXIMUM AMOUNT OF POWERQUEST'S LIABILITY AS STATED IN 12(b) ABOVE, BY REASON OF ANY 
REPRESENTATION OR IMPLIED WARRANTY, CONDITION OR OTHER TERM OR ANY DUTY AT LAW, OR UNDER THE 
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TERMS OF THIS AGREEMENT, FOR ANY CONSEQUENTIAL LOSS OR DAMAGE (WHETHER FOR LOSS OF PROFIT, 
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION OR OTHERWISE) ARISING OUT OF OR IN 
CONNECTION WITH ANY ACT OR OMISSION OF POWERQUEST RELATING TO THE USE OR INABILITY TO USE THE 
SOFTWARE BY THE END USER. 

FOR DENMARK, FINLAND AND NORWAY: IN NO EVENT SHALL POWERQUEST BE LIABLE TO THE END USER, EXCEPT 
(i) IN RESPECT OF DEATH OR PERSONAL INJURY CAUSED BY POWERQUEST'S GROSS NEGLIGENCE OR WILLFUL 
MISCONDUCT OR (ii) IF SUCH LIABILITY LIMITATION IS UNREASONABLE UNDER ALL RELEVANT CIRCUMSTANCES , 
FOR AN AMOUNT IN EXCESS OF THE MAXIMUM AMOUNT OF POWERQUEST'S LIABILITY AS STATED IN 12(b) ABOVE, 
BY REASON OF ANY REPRESENTATION OR IMPLIED WARRANTY, CONDITION OR OTHER TERM OR ANY DUTY AT 
LAW, OR UNDER THE TERMS OF THIS AGREEMENT, FOR ANY CONSEQUENTIAL LOSS OR DAMAGE (WHETHER FOR 
LOSS OF PROFIT, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION OR OTHERWISE) ARISING OUT OF 
OR IN CONNECTION WITH ANY ACT OR OMISSION OF POWERQUEST RELATING TO THE USE OR INABILITY TO USE 
THE SOFTWARE BY THE END USER. 

FOR PORTUGAL: IN NO EVENT SHALL POWERQUEST BE LIABLE TO THE END USER, EXCEPT IN RESPECT OF DEATH, 
DAMAGE TO PROPERTY OR PERSONAL INJURY CAUSED BY POWERQUEST'S GROSS NEGLIGENCE OR WILLFUL 
MISCONDUCT, FOR AN AMOUNT IN EXCESS OF THE MAXIMUM AMOUNT OF POWERQUEST'S LIABILITY AS STATED 
IN 12(b) ABOVE, BY REASON OF ANY REPRESENTATION OR IMPLIED WARRANTY, CONDITION OR OTHER TERM OR 
ANY DUTY AT LAW, OR UNDER THE TERMS OF THIS AGREEMENT, FOR ANY CONSEQUENTIAL LOSS OR DAMAGE 
(WHETHER FOR LOSS OF PROFIT, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION OR OTHERWISE AND 
WHETHER OCCASIONED BY POWERQUEST'S NEGLIGENCE OR ITS AGENTS OR OTHER REPRESENTATIVES) ARISING 
OUT OF OR IN CONNECTION WITH ANY ACT OR OMISSION OF POWERQUEST RELATING TO THE USE OR INABILITY 
TO USE THE SOFTWARE BY THE END USER. 

FOR SPAIN: IN NO EVENT SHALL POWERQUEST BE LIABLE TO THE END USER, EXCEPT IN RESPECT OF DEATH, 
DAMAGE TO PROPERTY OR PERSONAL INJURY CAUSED BY POWERQUEST'S BAD FAITH CONDUCT , FOR AN 
AMOUNT IN EXCESS OF THE MAXIMUM AMOUNT OF POWERQUEST'S LIABILITY AS STATED IN 12(b) ABOVE, BY 
REASON OF ANY REPRESENTATION OR IMPLIED WARRANTY, CONDITION OR OTHER TERM OR ANY DUTY AT LAW, 
OR UNDER THE TERMS OF THIS AGREEMENT, FOR ANY CONSEQUENTIAL LOSS OR DAMAGE (WHETHER FOR LOSS 
OF PROFIT, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION OR OTHERWISE) ARISING OUT OF OR IN 
CONNECTION WITH ANY ACT OR OMISSION OF POWERQUEST RELATING TO THE USE OR INABILITY TO USE THE 
SOFTWARE BY THE END USER. 

FOR SWEDEN, SWITZERLAND: IN NO EVENT SHALL POWERQUEST BE LIABLE TO THE END USER, EXCEPT IN RESPECT 
OF DEATH, DAMAGE TO PROPERTY OR PERSONAL INJURY CAUSED BY POWERQUEST'S GROSS NEGLIGENCE OR 
WILLFUL MISCONDUCT, FOR AN AMOUNT IN EXCESS OF THE MAXIMUM AMOUNT OF POWERQUEST'S LIABILITY 
AS STATED IN 12(b) ABOVE, BY REASON OF ANY REPRESENTATION OR IMPLIED WARRANTY, CONDITION OR OTHER 
TERM OR ANY DUTY AT LAW, OR UNDER THE TERMS OF THIS AGREEMENT, FOR ANY CONSEQUENTIAL LOSS OR 
DAMAGE (WHETHER FOR LOSS OF PROFIT, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION OR 
OTHERWISE) ARISING OUT OF OR IN CONNECTION WITH ANY ACT OR OMISSION OF POWERQUEST RELATING TO 
THE USE OR INABILITY TO USE THE SOFTWARE BY THE END USER. 

FOR THE UNITED KINGDOM: IN NO EVENT SHALL POWERQUEST BE LIABLE TO THE END USER, EXCEPT IN RESPECT 
OF (a) DEATH OR PERSONAL INJURY CAUSED BY POWERQUEST'S NEGLIGENCE OR (b) DAMAGE TO PROPERTY OR 
OTHER LOSS CAUSED BY POWERQUEST WHERE SUCH LIABILITY LIMITATION IS UNREASONABLE UNDER ALL 
RELEVANT CIRCUMSTANCES. FOR AN AMOUNT IN EXCESS OF THE MAXIMUM AMOUNT OF POWERQUEST'S 
LIABILITY AS STATED IN 12(b) ABOVE, BY REASON OF ANY REPRESENTATION OR IMPLIED WARRANTY, CONDITION 
OR OTHER TERM OR ANY DUTY AT LAW, OR UNDER THE TERMS OF THIS AGREEMENT, FOR ANY CONSEQUENTIAL 
LOSS OR DAMAGE (WHETHER FOR LOSS OF PROFIT, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION 
OR OTHERWISE) ARISING OUT OF OR IN CONNECTION WITH ANY ACT OR OMISSION OF POWERQUEST RELATING 
TO THE USE OR INABILITY TO USE THE SOFTWARE BY THE END USER.

13. This License constitutes the entire agreement between the End User and PowerQuest pertaining to its subject matter. This 
License is governed by the laws of the State of Utah (except that body of laws controlling conflict of laws).

For further information: Should the End User have any questions concerning this Agreement, or if the End User desires to 
contact PowerQuest for any reason, please write: PowerQuest Corporation. P.O. Box 1911/Orem/UT 84059-1911 U.S.A.

© 1994–1999, PowerQuest Corporation. All rights reserved. U.S. Patents 5,675,769 and 5,706,472, with other patents 
pending. PowerQuest is a registered trademark and Server Image is a trademark of PowerQuest Corporation.
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Introduction

What is Server Image?

Setting up servers is a time-consuming and costly process. Long hours are spent installing and 
configuring operating systems and software individually on each server. Companies need a fast, 
inexpensive solution for setting up new servers and/or upgrading existing servers.

Server Image is designed for NetWare administrators who need a fast, effective, and complete 
system for server deployment. With Server Image, you can easily create images of NetWare 
partitions, including the DOS boot partition, and store the images on removable media, local, or 
network hard drives, even CD-Rs once the image has first been created on another media. Using 
patent-pending SmartSector™ technology, Server Image is able to create compressed image files 
of DOS and NetWare partitions, greatly reducing the amount of room required to store image 
files. Once created, you may use the server images to deploy new servers for your organization 
and to quickly bring servers online.

Server Image, with its SmartSector technology, is up to ten times faster than other image methods 
using straight file-by-file methods, because it records using only the used data sectors. The speed 
with which Server Image operates saves administrators valuable time when deploying servers.

PowerQuest’s Server Image lets you easily create a compressed image file of an entire hard drive 
or of individual partitions. Image files can be stored on a network, secondary hard drive, or other 
removable media device. Simply download the image file from the source to quickly set up new 
servers. With Server Image, image files can be applied to same-size drives or resized to fit drives 
of a different size and geometry.
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Server Image runs in either interactive or batch mode, allowing you to customize the 
program’s operation to fit your needs. Interactive mode gives you control plus efficiency 
when working with one or two servers, while batch mode allows you to easily automate 
the setup process for deploying multiple servers.

NOTE:  Currently, Server Image does not support creating image files directly on CD-R or 
tape drives. You must first save image files to a supported source (hard drive, Zip 
drive, etc.), then copy them to CD-R or tape. Server Image can, however, directly 
restore image files from CD-R.

Furthermore, image files can only be saved to devices that have a valid drive letter. 
The user is primarily responsible for loading the necessary drivers for his/her data 
storage devices so that DOS can correctly assign drive letters.

Server Image is optimized for use with NetWare 3.12, 4.10, 4.11, and 5.0, and all 
versions of DOS and MS-DOS 5.0 and above. Server Image also supports the file systems 
of all versions of Windows 95, Windows NT, Windows 3.x, and OS/2, including FAT16, 
FAT32, FAT32X, NTFS, and HPFS partition types. Because Server Image understands the 
internal structure of these file systems, partition resizing and fast SmartSector copying 
can occur. PowerQuest recommends you use Server Image for imaging the DOS and 
NetWare partitions on NetWare servers and use Drive Image or Drive Image Pro for 
workstations.

Server Image is a DOS-based program that can be run from the hard drive in DOS or MS-
DOS mode or from a floppy diskette after booting DOS. Only by running in DOS is the 
hard drive completely inactive with no open files.
Introduction



                        
Server Image System Requirements  

IMPORTANT!  Because of operating system conflicts that can result from different hardware 
configurations, Server Image is not intended to copy or image a hard drive 
used in a system with different hardware configurations. If you create an 
image of one server and wish to restore the image on a machine with a 
different configuration (e.g., network interface card, IDE vs. SCSI drives, 
etc.), the server may not boot correctly. Therefore, we recommend verifying 
and restoring to similar hardware configurations.

NOTE:  Any discussion of deployment, including hard-disk imaging, assumes that the 
software, including the operating system, is being copied in accordance with the 
license agreements with the software manufacturers.

Hardware/Software Minimum Recommended

Processor Intel 386SX Intel 486 or above

RAM 8 MB (16 MB required for FAT32 or 
NTFS)

32 MB (48 MB for FAT32 
partitions larger than 6 GB)

3.5-inch diskette drive None 3.5-inch diskette drive

CD-ROM drive Any speed Any speed

Hard drive free space 2 MB 2 MB

Operating System DOS 5.0 DOS 6.22 or 6.3

Monitor VGA SVGA

Pointing Device No pointing device is required to 
operate Server Image.

Microsoft mouse (or compatible 
pointing device)
Server Image System Requirements 3
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Getting Started

This chapter contains the following information:

Installing Server Image 

Before Using Server Image

Loading External Drive Device Drivers from DOS

Running Server Image

Using Server Image in a Network Environment

Uninstalling Server Image
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Installing Server Image

You can install Server Image from DOS, version 5.0 or later.

To install Server Image:

1. Insert the ServerMagic CD into your CD-ROM drive.

2. At the DOS prompt, change to the CD-ROM drive.

3. Run INSTALL.BAT from the \SIMAGE directory.

4. Click Next and follow the on-screen instructions.

Before Using Server Image

Before using Server Image, it is important that you run a disk utility such as ScanDisk or 
CHKDSK on each partition of the source drive to check for file system errors.

Loading External Drive Device Drivers from DOS

To use Server Image with external drives, you must load the external device drivers from 
DOS. For specific information on setting up a DOS bootable floppy or loading a DOS 
device driver, contact your manufacturer directly. See the following section for a listing 
of External Drive Manufacturer's Internet addresses.

External Drive Manufacturer’s Contact Information

Iomega: 
http://www.iomega.com

SyQuest: 
http://www.syquest.com

Cheyenne: 
http://www.cheyenne.com

Panasonic: 
http://www.panasonic.com
Chapter 1:  Getting Started



                        
Running Server Image

There are two ways to run Server Image. You can run Server Image from the hard drive if 
you booted in DOS or MS-DOS mode or from the CD-ROM. 

Running Server Image from the CD-ROM

1. Boot with a floppy disk.

2. Run PQSI.EXE from the CD.

If you want to run Server Image from your hard drive:

1. At a DOS prompt, change to the drive and directory which contains Server Image.

2. Type PQSI.EXE.

Running Server Image from a Floppy Diskette

1. Insert a bootable diskette.

2. Reboot your machine.

3. Insert your Server Image program diskette. Type A:\PQSI and press <Enter>.

NOTE:  The mouse driver is automatically loaded by PQSI.EXE. If you have a 
low-memory situation and need to load the server after using Server Image, type 
the command MOUSE OFF in the \SIMAGE directory to unload the mouse 
driver. This will increase available RAM for use by other programs by 
approximately 100 KB.
Running Server Image 7
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Using Server Image in a Network Environment

Server Image simplifies the installation of network operating systems and/or software to 
multiple servers by creating image files that may be distributed from a central server.

Creating a NetWare Boot Diskette
To upload or download image files, computers running DOS must be able to connect to 
the desired server, which requires a network boot diskette.

To create a NetWare boot diskette:

1. Create a DOS boot diskette using the FORMAT /S command.

2. Copy the following files to the formatted system diskette:

• LSL.COM

• <the network interface card driver>

• IPXODI

• Any VLMs appropriate to your network

After the network files and drivers are copied to the boot diskette, booting any DOS 
computer from the diskette will bring up the standard NetWare login prompt.

Using Jaz, Zip, and SyQuest Parallel Port Devices with a NetWare Client
Loading a parallel port device with a network client in memory may cause the system to 
hang. To successfully load the device driver for a parallel port drive, reboot the system 
without loading the network client.

Uninstalling Server Image

To uninstall Server Image:

Change to the drive where \SIMAGE is located.

1. Type DELTREE SIMAGE and press <Enter>. Press <Y> and <Enter> to confirm the 
deletion.
Chapter 1:  Getting Started
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Menu Options

This chapter contains the following information:

Tools Menu Options

Help Menu Options
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Tools Menu Options

The Tools drop-down menu on the Server Image main screen lets you manually perform 
some common partition-management tasks that Server Image automatically performs 
when it processes image files or when it copies partitions. The Tools menu gives you 
access to these useful features without requiring you to create or restore image files.

Create Extended Partition
If you create an image of a primary partition and want to restore it as a logical partition, 
you must first have an extended partition on your hard drive.

NOTE:  It is not necessary to manually create an extended partition when you restore an 
image of a logical partition. Server Image automatically creates an extended 
partition if one does not already exist.

To create an extended partition:

1. At the Server Image main screen, select Tools > Create Extended Partition.

The Create Extended Partition window appears.

Create Extended Partition

2. If you have more than one hard drive on your system, select the desired drive from 
the Physical Drives drop-down list box.
Chapter 2:  Menu Options



 

3. Select a free space.

A check mark appears to the left of the selected free space.

If there is no free space (unpartitioned area) on your drive, you must delete an 
existing partition to create free space. 

4. Click Create.

Server Image creates an extended partition in the selected free space.

5. Click Close to return to the Server Image main screen.

Delete Partitions
This feature deletes existing partitions to create free space on your hard drive. 

WARNING!  Be aware that deleting existing partitions DESTROYS any data they contain.

To delete partitions:

1. At the Server Image main screen, select Tools > Delete Disk Partition(s).

The Delete Partition(s) window appears.

Delete Partitions

2. If you have more than one hard drive on your system, select the desired drive from 
the Physical Drives drop-down list box.

3. Select the partition you wish to delete.

A check mark appears to the left of the selected partition.
Tools Menu Options 11
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4. Click Delete.

The following message appears: 

“Selected partition:<partition letter>. Deleting this partition will DESTROY any 
existing data! Current volume label is <volume label>. Enter current volume label to 
confirm partition deletion:”

5. Type the volume label, and click OK. Server Image deletes the partition and displays 
the message: “Volume <volume name> was deleted successfully.”

For NetWare partitions, type UNKNOWN as the partition label.

6. Click Close to return to the Server Image main screen.

Hide/Unhide Partitions
The Hide/Unhide feature allows you to protect partitions from unwanted user access. 
When you hide a partition, it is inaccessible. If you unhide a partition, it is accessible 
again.

WARNING!  Before hiding and unhiding partitions, be aware of the following:

• Hiding or unhiding a partition can cause the drive letters of subsequent 
partitions to change. This may make the computer fail to boot or cause 
applications to fail. If your hard drive contains more than one primary 
partition, only one is visible by default. When you use the Set Active Partition 
feature, Server Image unhides the selected primary partition and automatically 
hides all other primary partitions (for more information, see the following 
section).

• Because a hidden partition is not bootable or accessible, if you hide the 
partition where Server Image is installed, you must re-install Server Image on 
your new active (bootable) partition to run it again.
Chapter 2:  Menu Options



To hide/unhide partitions:

1. At the Server Image main screen, select Tools > Hide/Unhide Partition(s).

The Hide Partition(s) window appears.

Hide partitions

2. If you click on a visible partition, the Hide button is available.

Click Hide to hide the selected partition. The partition status changes to “Hidden.”

3. If you click on a hidden partition, the Unhide button is available.

Click Unhide to unhide the selected partition. The partition status changes to “None.”

4. Click Close to return to the Server Image main screen.

5. Click Exit to exit Server Image.

6. Reboot your computer.
Tools Menu Options 13
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Set Active Partition
The Set Active Partition feature allows you to make a primary partition the active 
(bootable) partition. Only one primary partition can be active at a time. To be bootable, a 
primary partition must be located on the first (Master) drive, and it must contain an 
operating system. When your computer boots, it scans the partition table of the first drive 
to find the active partition, then boots from that partition.

WARNING!  Before you set an active partition, be sure it is bootable. If it is not bootable or 
if you are not sure, locate a boot disk. If you restart your computer, and it does 
not boot normally, you must boot from your floppy disk, run Server Image 
from the CD-ROM, and set a different active partition.

1. At the Server Image main screen, select Tools > Set Active Partition.

The Set Active Partition window appears.

Set Active Partition

2. Make sure that Disk 1 is selected in the Physical Drives drop-down list box.

3. Select a primary partition that is not currently active.

A check mark appears to the left of the selected partition.

4. Click Set Active.

The status of the selected partition changes to “Active.”

5. Click Close.

6. Click Exit to exit Server Image.

7. Reboot your computer.
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Help Menu Options

Server Image provides online help to assist you in performing various tasks. The Help 
Menu at the Server Image main screen gives you a brief overview of the online help 
system, lets you access the Help Index, and provides information about Server Image. In 
addition to the Help menu, you can press <F1> at any time to access the Help Index.

Contents

1. Select Help > Contents to display general instructions for using Server Image Help.

2. Click Show Index to display a list of all help topics. Double-click a topic to display 
information on that subject.

3. Click Close to exit Help and return to the Server Image main screen.

About
Select Help > About to display Server Image’s version, copyright, and patent information 
as well as PowerQuest contact information.
Help Menu Options 15
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This chapter contains the following information:

Preparation

Procedure

Advanced Options

Scenarios



18
Preparation

1. Before running Server Image, use a disk utility program such as ScanDisk or Norton’s 
Disk Doctor to identify and repair any errors on your hard drive.

NOTE:  NT users should run CHKDSK /F.

2. You may also choose to run a disk defragmenting utility to further optimize your hard 
drive. 

Procedure

To create an image of the contents of any partition:

1. At the Server Image main screen, click Create Image.

Server Image Main Screen

If you have only one hard drive, skip to step 4.
Chapter 3:  Creating Image Files



2. If you have more than one hard drive, select the drive that contains the partitions you 
wish to include in the image file.

A check mark appears to the left of the selected drive.

NOTE:  Because DOS is limited to eight drives, you will not be able to see or manipulate 
drives past the eight-drive limit.

Select Source Drive

3. Click Next.

NOTE:  At any point prior to actual image file creation, you may click Back to return to 
the previous step and change your settings.
Procedure 19
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4. Select the source drive partitions you wish to include in the image file, or click Select 
All to automatically select all partitions.

A check mark appears to the left of the selected partitions.

Select Source Partition

To deselect partitions, click again on a partition, or click Select None to deselect all 
partitions at once.

The Total Selected field keeps a running total of the disk space for all selected 
partitions, as well as the total used and free space within the partitions.

5. Click Next.
Chapter 3:  Creating Image Files



6. Type the desired path and image filename in the Image File field, for example: 
D:\MYIMAGE.PQI.

NOTE:  Server Image uses .PQI as the default image filename extension.

Name Image File

NOTE:  You must save your image file to a partition that you are NOT including in your 
image file.

If the drive and directory are not specified in the filename, Server Image 
automatically saves the image file to the Server Image program directory, \SIMAGE.

You may also click Browse to browse the directory tree for your desired path and/or 
filename. If you select a pre-existing image file, the following message appears: 

“Image File already exists. Do you want to replace file? Yes/No. WARNING: Existing 
data in file will be lost.” 

If Yes is selected, Server Image immediately deletes the existing file.

You can save your image file to any physical or logical drive which has a drive letter. 
That includes floppy drives, secondary hard drives, network drives, and removable 
media storage devices such as Jaz, Zip, SyQuest drives, etc. (For more information, 
see “Scenarios” on page 27.) 

NOTE:  You can type brief comments about your image file in the Image File Comments 
field.

7. Click Next.
Procedure 21



22
8. Select the desired compression level.

• No Compression is the fastest method for creating an image file and is useful if 
storage space is not an issue. (For an exception to this, see the tip below.) Server 
Image selects No Compression by default.

• Low offers a 40% average compression ratio.

• High offers a 50% average compression ratio.

Compress Image File

TIP:  If you are saving your image file to a busy network drive or to a relatively slow 
removable media device, compression may be faster than no compression, since 
there is less data to write to the file.
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9. Click Next.

Server Image displays all the information you have entered to this point:

• Source Drive

• Source Partitions (partitions to be included in the image file are marked with an 
“X”)

• Image Filename

• Compression Level

Ready to Create Image File

If you wish to modify any settings, click Back to backtrack and make changes.

10. Click Advanced Options to set such options as disabling file system error-checking or 
password-protecting your image file.

NOTE:  For information on Advanced Options settings, see “Advanced Options” on 
page 25.
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11. Click Finish to begin creating the image file.

If Server Image detects that you are saving your image file to a floppy drive or 
removable media, it enables a media-spanning feature that spreads the image file 
over a series of disks. Server Image permits you to span a maximum of 50 disks with 
a limit of 12 partitions per image file. You must have at least 100K of available space 
on each disk in the series. If you use the media-spanning feature, be sure to number 
the disks in order, since you must insert them in sequence when restoring the image 
file. (For more information, see “Creating an Image File on a Zip Drive” on page 27.) 

The Creating the Image dialog appears, tracking the following items:

• Image filename

• Estimated megabytes to copy

• Total megabytes copied

• Entire process progress bar

• Information about current partition (volume, type, size MB, used MB, free MB)

• Sub-process progress bar

• Transfer rate for current partition

• Total megabytes copied for current partition

• Time elapsed

• Estimated time remaining

Upon completion, the following message appears: “Image was copied successfully to 
file: <image filename>. “

12. Click OK to return to the Server Image main screen.
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Advanced Options

The Create Image Advanced Options group box appears when you click Advanced 
Options at the Ready To Create Image File screen. The following options are available 
from the Create Image Advanced Options group box:

Create Image Advanced Options

Check for File System Errors
Unmark the Check for File System Errors check box if you want to disable error 
checking.

If you have already used a disk utility program such as ScanDisk to check your hard drive 
for errors, it is not necessary to have Server Image check for file system errors. 
Unmarking Check for File System Errors saves time in creating the image file.

If you did not run a disk utility program before loading Server Image, leave the Check for 
File System Errors check box marked.
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Disable SmartSector Copying
Server Image’s SmartSector technology speeds up the data copying process by only 
copying clusters and sectors that contain data. However, in some cases, such as 
high-security environments, it may be desirable to copy all clusters and sectors in their 
original layout, whether or not they contain data.

If you wish to copy both used and unused clusters and sectors, mark the Disable 
SmartSector Copying check box.

NOTE:  Disabling SmartSector copying increases processing time.

Verify Disk Writes
Mark the Verify Disk Writes check box if you want to enable DOS disk write verification.

NOTE:  Disk write verification is not critical to safely create image files. Enabling disk write 
verification can slow the image file create process by as much as seven times.

ImageShield
If you wish to password-protect your image file, mark the Password Protect Image File 
check box, and type a password in the Password field.

IMPORTANT!  Be sure to note image file passwords and store them in a safe place. If you 
forget an image file’s password, you cannot restore the file.

Split Image File Into Multiple Files
Because Server Image does not directly support CD-R, it cannot span large image files 
over several CDs. Therefore, you must force Server Image to split the large file into 
smaller, discrete files which you can save to CDs after you exit Server Image (see “Storing 
an Image File on CD-ROM” on page 28).

To force Server Image to split large image files into smaller files, mark the Split Image File 
Into Multiple Files check box, and enter the maximum byte size for each file in the File 
Size (bytes) field. If you wish to save the files to CDs, specify a file size of 650,000,000 
bytes (650 MB) or less.
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Scenarios

Creating an Image File on a Zip Drive

Sample System Configuration
One 1.2 GB hard drive containing:

• One active primary DOS partition (C:); 50 MB used and 100 MB unused.

• One NetWare 4.11 partition containing SYS(0); 700 MB used and 350 MB unused.

One Zip drive (E:).

Objective
Create an image file of your DOS and NetWare partitions, and store them on your Zip 
drive.

Procedure

1. Down the server and reboot to a DOS prompt. Ensure your machine is configured 
correctly to read and write to the Zip drive.

2. Since the image will be too large to fit on one Zip disk, you must create a series of 
Zip disks.

Label the first Zip disk as “MYIMAGE DISK #1”. During the image file creation 
process, Server Image prompts you to insert new disks as needed. Label each 
successive disk “MYIMAGE DISK #2,” “MYIMAGE DISK #3,” etc.

3. Insert the Zip disk labeled “MYIMAGE DISK #1” into your Zip drive, then run Server 
Image.

4. From the main screen, click Create Image.

5. Disk 1 (your hard drive) should already be selected. Click Next.

6. Select the DOS and NetWare partitions, then click Next.

7. In the Image File field, type E:\MYIMAGE.PQI. Enter any comments (optional), then 
click Next.

8. Select High compression, then click Next.

High compression compacts the image of your partitions by approximately 50%.
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9. From the Ready to Create Image File screen, click Advanced Options.

10. Unmark the Check for File System Errors box, then click OK.

11. Click Finish.

12. When Server Image prompts you to insert the next disk in the series, wait until the 
busy light on the Zip drive goes out, remove “MYIMAGE DISK #1” from the Zip 
drive, and insert “MYIMAGE DISK #2”.

13. After Server Image has completed the image create process, click OK to return to the 
Server Image main screen and exit the program.

Result
Your DOS and NetWare partitions are stored on several Zip disks (depending on how 
much data was in the partitions) in a spanned image file. You can restore these partitions 
to any hard drive which has at least 1.2 GB of available space.

Storing an Image File on CD-ROM

Sample System Configuration
One 3 GB hard drive containing:

• One active primary MS-DOS partition (C:); 60 MB used and 140 MB unused.

• One NetWare 5.0 partition containing SYS(0) and APPS(0); 2.2 GB used and 600 MB 
unused.

One CD-ROM drive (D:).

Objective
Create an image file of your NetWare 5 partition, and store it on CD-ROM.

Procedure

1. Since the image file will be too large to fit on one CD, you must create a series of 
CDs.

Label the first CD as “NW5 #1” and the second as “NW5 #2”, etc.

2. Down the server and reboot the machine, logging into the network so you can save 
the image to a network drive.

3. Run Server Image.
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4. From the Server Image main screen, click Create Image.

5. Disk 1 (your hard drive) should already be selected. Click Next.

6. Select the NetWare partition.

7. In the Image File field, type <drive letter>:\NW5.PQI, where drive letter is a 
network drive where you have full rights. Enter any comments (optional). Click Next.

Because Server Image does not directly support CD-ROM, you must first save the 
image file to a partition on your hard drive, a secondary hard drive, a network drive, 
or a removable media device. In this scenario, you must save NW5.PQI to the 
network.

8. Select a compression level, then click Next.

9. From the Ready to Create Image File screen, click Advanced Options.

10. Unmark the Check for File System Errors box.

11. Mark the Split Image File Into Multiple Files check box and enter 650,000,000 in the 
File Size (bytes) field. Click OK.

12. Click Finish.

13. After Server Image has completed the image create process, click OK to return to the 
Server Image main screen and exit the program.

14. Change to the network drive and directory to view the image file listing. You will find 
several image files, NW5.PQI, NW5.002, NW5.003, etc., on the network.

15. Using a third-party CD authoring program, such as Adaptec’s CD Creator, burn 
NW5.PQI onto your CD labeled “NW5 #1” and NW5.002 onto the CD labeled 
“NW5 #2,” etc.

Result
Your 2.8 GB NetWare partition is stored on CD-ROMs in several separate image files. 
You can restore this NetWare partition to any hard drive that has at least 2.8 GB of 
available space.
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Restoring Image Files

This chapter contains the following information:

Procedure

Resize Options

Advanced Options

Scenarios

NOTE:  Any discussion of deployment, including hard-disk imaging, assumes 
that the software, including the operating system, is being copied in 
accordance with the license agreements with the software 
manufacturers.
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Procedure

To restore an image file to any drive:

1. At the Server Image main screen, click Restore Image.

2. In the Image File field, enter the complete filename of the image file you wish to 
restore, or click Browse to browse the directory tree for the desired path and image 
filename.

NOTE:  If you need to access your CD-ROM drive from Server Image, you need to add 
the command in the CONFIG.SYS file to load your CD-ROM driver and add the 
command in the AUTOEXEC.BAT file to load the CD-ROM extensions, for 
example, MSCDEX.EXE.

Select Image File

3. Click Next.

NOTE:  At any point prior to actual image file restore, you may click Back to return to 
the previous step and change your settings.
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4. Select the image file partitions you wish to restore, or click Select All to automatically 
select all partitions.

A check mark appears to the left of the selected partitions.

Select Image File Partition

To deselect partitions, click again on a partition, or click Select None to deselect all 
partitions at once.

The Total Selected field keeps a running total of the disk space for all selected 
partitions, as well as the total used and free space within the partitions.

5. Click Next.
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6. Select the drive to which you want to restore the image file.

Select Destination Drive

7. Click Next.

8. Select an existing partition or free space (non-partitioned disk space).

Select Destination Partition or Free Space
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9. If the destination partition or free space is not large enough to accommodate the 
partitions you wish to restore, or if you are restoring the image file to a larger drive 
and want to set a specific size for partitions rather than use the proportional resize 
option, you can click Resize Partitions to specify different sizes for restored 
partitions. To resize partitions:

a. Click Resize Partitions.

The Resize Partitions window appears.

Resize Partitions: Main Window

The Selected Source Partitions group box displays the partitions you selected to 
restore.

The Totals field displays the disk space for the source partitions, as well as the total 
used and free space within the partitions.

A formula box below the Totals field displays the following information:

• Destination Size

• Current Size of Selected Partition

• Remaining Space in Destination
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b. Click Resize.

The Resize Partition window appears.

Resize Partition: Enter New Size

Maximum Size displays the largest possible size the source partitions can have 
and still fit in the destination space.

Minimum Size shows the smallest possible size the source partitions can occupy.

c. In the New Size field, enter a number that is less than the Maximum Size and 
greater than or equal to the Minimum Size.

d. Click OK.

Since partitions must end on a cylinder boundary, Server Image rounds the New 
Size up to the next cylinder boundary.

e. Click Accept.

Later, when you restore the image file, Server Image resizes the partition.

10. Click Next.

If you selected an existing partition as the destination, the following message 
appears: 

“Item selected is not free space. Disk Images can only be restored into existing free 
space. Server Image will delete this partition before restoring disk image. WARNING: 
Deleting a partition will DESTROY any existing data on that partition.” 

Server Image does not delete the partition until you click Finish on the Ready to 
Restore Image File screen.

If the free space on the destination drive is greater than the space required to restore 
the selected partitions, the Resize Options dialog appears.

NOTE:  For information about resize option settings, see “Resize Options” on page 39.
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11. Server Image displays all the information you have entered to this point:

• Image filename

• Selected image file partitions

• Destination drive

• Destination space

Ready to Restore Image File

If you wish to alter any settings, click Back to backtrack and make changes.

12. If you wish to enable bad-sector checking or hide partitions after restore, click 
Advanced Options.

For information on Advanced Options settings, see “Advanced Options” on page 40.

WARNING!  Restoring multiple logical partitions can cause the drive letters of 
subsequent partitions to change. This may make the computer unbootable 
or cause applications to fail. 
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13. Click Finish to begin restoring the image file.

If you assigned a password to the image file when you created it, the Get Image File 
Password dialog appears. You must enter the password in order to restore the image 
file.

If Server Image detects that you are restoring your image file from a floppy drive or 
removable medium, it enables a media-spanning feature that is capable of reading 
the image file from a series of disks. As Server Image prompts you for each disk, be 
careful to insert the disks sequentially. For more information, see “Restoring an Image 
File from a Zip Drive” on page 41. 

The Restoring the Image dialog appears, tracking the following items:

• Image filename

• Estimated megabytes to restore

• Total megabytes copied

• Entire process progress bar

• Information about current partition (volume, type, size MB, used MB, free MB)

• Sub-process progress bar

• Transfer rate for current partition

• Total megabytes copied for current partition

• Time elapsed

• Estimated time remaining

Upon completion, the following message appears: “Image was restored successfully. 
Would you like to view results?”

14. Click Yes to view results, or No to return to the Server Image main screen.
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Resize Options

The following options are available when restoring partitions if the free space on the 
destination drive is greater than the space required by the partitions.

Resize Options

Automatically resize partitions proportionally to fit
Mark this option to allow Server Image to automatically expand the partitions in equal 
proportions to occupy the destination drive’s remaining free space.

Leave remaining free space
Mark this option if you want to leave any remaining free space unused on the destination 
drive after the partitions are restored.

Resize partitions manually to fit
Mark this option to display the Resize Partition window where you can manually set the 
size of the partitions to fit in the destination drive’s remaining free space.

NOTE:  For more information on resizing partitions, see step 9 of the “Procedure” section 
on page 35.
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Advanced Options

The Restore Image Advanced Options group box appears when you click Advanced 
Options at the Ready To Restore Image File screen. The following options are available 
from the Restore Image Advanced Options group box:

Restore Image Advanced Options

Skip Bad Sector Check
This is marked by default to save time in restoring the image file.

Although most drives do not have bad sectors, the potential for problems increases 
during the lifetime of the hard drive. If you have an older hard drive, it is wise to enable 
bad-sector checking by removing the mark from the Skip Bad Sector Check box.

Verify Disk Writes
Mark the Verify Disk Writes check box if you want to enable DOS disk write verification.

NOTE:  Disk write verification is not critical to safely restore image files. Enabling disk write 
verification can slow the image restore process by as much as seven times.

Hide Partition After Restore
Most operating systems only allow one primary partition to be visible (bootable) at a 
time. If you are restoring an image of a primary partition, and you do not want to make 
that partition your visible (bootable) partition, mark the Hide Partition After Restore box.
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Scenarios

Restoring an Image File from a Zip Drive

Sample System Configuration
One 2.1 GB hard drive containing:

• One active primary DOS partition (C:); 60 MB used and 140 MB unused.

• 1.9 GB unpartitioned free space.

One CD-ROM drive (D:).

One Zip drive (E:).

Objective
Restore a DOS and NetWare 4.11 partition from an image file (MYIMAGE.PQI) which 
spans several Zip disks. You wish to restore the DOS partition over the existing DOS 
partition on the hard drive and the NetWare partition into the unpartitioned free space 
on your hard drive, and resize it to 1.9 GB.

Procedure

1. Run Server Image.

NOTE:  You must have the Zip drivers properly configured and loaded prior to running 
Server Image. 

2. From the Server Image main screen, click Restore Image.

3. Insert the Zip disk you labeled as “MYIMAGE DISK #1” into your Zip drive.

4. In the Image File field, type E:\MYIMAGE.PQI, then click Next.

You may also click Browse to browse the directory tree for your Zip drive and the 
desired image file.

5. Click the Select All button, then click Next.

6. Disk 1 should already be selected. Click Next.

7. Click Delete Disk Partition(s).

8. In the Delete Partition(s) window, select the DOS partition on your hard drive. Click 
Delete. 
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9. Enter the partition label and click OK.

10. Click Close to exit the Delete Partition(s) window, then click Next.

11. When the Resize Options window appears, select Resize partitions manually to fit, 
then click OK.

12. In the Resize Partitions window, adjust the size of the NetWare partition to 1.9 GB 
(to take up the rest of the hard drive). Click Accept.

13. Click Finish.

14. When Server Image prompts you to insert the next disk in the series, remove 
“MYIMAGE DISK #1” from the Zip drive and insert “MYIMAGE DISK #2”.

15. After Server Image has completed the image restore, click OK to return to the Server 
Image main screen and exit the program.

16. Reboot your computer.

17. Load the server. Load INSTALL.NLM and add the additional space in the NetWare 
partition to the SYS: volume, or make it a new volume.

Result
After reboot, your hard drive has an active primary partition (C:) and a NetWare partition 
containing SYS(0). 
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Restoring an Image File from a CD-ROM Drive

Sample System Configuration
One 8 GB hard drive, unformatted (this will be a new server).

One CD-ROM drive (D:).

Objective
Restore the DOS and NetWare 5 partitions from CD-ROM to create a new server.

Procedure

1. Boot the machine with a boot diskette and run Server Image from the program CD. 
Ensure that the boot diskette contains the correct drivers for the CD-ROM drive.

To access your CD-ROM drive from Server Image, add the command in the 
CONFIG.SYS file to load your CD-ROM driver and add the command in the 
AUTOEXEC.BAT file to load the CD-ROM extensions, for example, MSCDEX.EXE.

2. From the Server Image main screen, click Restore Image.

3. Insert the CD-ROM you labeled as “NW5 #1” into your CD-ROM drive.

4. In the Image File field, type D:\NW5.PQI. Click Next.

You may also click Browse to browse the directory tree for your CD-ROM drive and 
the desired image file.

5. Click Select All, then click Next.

6. Disk 1 should already be selected. Click Next.

7. Click Resize Source Partition(s).

8. In the Resize Partitions window, click Resize and change the size of the NetWare 
partition to the maximum size. Click OK, then Accept.

9. Select the free space, then click Next.

10. Click Finish.

11. When Server Image prompts you to insert the next disk in the series, remove “NW5 
#1” from the CD-ROM drive and insert “NW5 #2”.
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12. After Server Image has completed the image restore, it prompts you to select a 
primary partition to set active (bootable). Select the DOS partition.

13. Click OK to return to the Server Image main screen and exit the program.

14. Reboot your computer.

15. Using the information in Chapter 5, “Using Server Image to Deploy NetWare 
Servers,” reconfigure the server to make it unique in the directory tree. 

NOTE:  Ensure you have the appropriate NetWare license diskette, and update the 
server’s license.

Result
The restored partitions contain all the data from the original server, but the NetWare 
partition has been expanded to include most of the 8 GB hard drive.
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C H A P T E
 R 5

Deploying NetWare Servers

This chapter contains the following information:

Using Server Image to Deploy NetWare Servers

Deploying a New Server

Hardware Configurations

Using Hide/Unhide for Backup Purposes

NOTE:  Any discussion of deployment, including hard-disk imaging, assumes 
that the software, including the operating system, is being copied in 
accordance with the license agreements with the software 
manufacturers.
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Using Server Image to Deploy NetWare Servers

When using Server Image to deploy servers, several issues need to be taken into account 
to restore a NetWare 4.x or 5.0 server. If you deploy the server within the same Directory 
tree as the original server, the following parameters need to be edited:

• Server Name in the AUTOEXEC.NCF file

• IPX Internal Network Number

• NIC Driver

• NIC I/O Address and Slot Number of the NIC

• Network Segment Number Bound to the NIC

• Server License

Server name
Because every server in a NetWare Directory tree must have a unique server name, you 
need to edit the AUTOEXEC.NCF file and specify a new name for the deployed server. 
You may do this from the server console with EDIT.NLM. At the server console, type the 
appropriate command for your version of NetWare:

• For NetWare 3.12, 3.2, or 4.x, type LOAD EDIT and press <Enter>.

• For NetWare 5.x, type EDIT and press <Enter>.

Type the name and location of the file to edit (typically this is 
SYS:SYSTEM\AUTOEXEC.NCF.)

Find the line that reads “file server name server1” where server1 is the name of the 
deployed server, then replace the text with the new server’s name.

IPX Internal Network Number
You must also assign a unique IPX internal network number to every server within a 
Directory tree. Assign this number within the AUTOEXEC.NCF file. You can change this 
number from the server console with EDIT.NLM. At the server console, type the 
appropriate command for your version of NetWare:

• For NetWare 3.12, 3.2, or 4.x, type LOAD EDIT and press <Enter>.

• For NetWare 5.x, type EDIT and press <Enter>.
Chapter 5:  Deploying NetWare Servers



Type the name and location of the file to edit (typically this will be 
SYS:SYSTEM\AUTOEXEC.NCF.)

Find the line that reads “ipx internal net abcd0123” where abcd0123 is the internal 
network number assigned to the original server when it was initially installed. Replace 
the original number with the new, unique IPX internal number.

NIC Driver
If you restore the image to a system with a network interface card (NIC), which is a 
different make or manufacture than initially installed in the source server, you must 
change the NIC driver for that card to reflect the correct network card and driver. If you 
used INETCFG to configure the NIC driver originally, update it by loading 
INETCFG.NLM at the server console and installing the correct driver. Although 
PowerQuest does not recommend restoring server images to systems with different 
hardware configurations, altering the NIC driver is a relatively simple task.

NIC I/O Address and Slot Number
You may also need to edit the I/O address or the slot number of the network board to 
reflect a different location if the server image is restored to a system with a different 
configuration. For example, if you create an image of a server with the NIC in slot 2, then 
restore the image to a server with the NIC in slot 3, the NIC slot number must be 
changed to reflect the correct location.

Network Segment Number
If you deploy a server to a new network, one with a different segment address, you must 
enter the correct IPX external network number to reflect the deployed server’s location.

Server License
In all cases when you image and deploy a server to a new system, you need to install a 
new license that supports the correct number of connections required by the new 
system. You can change the server license by loading INSTALL.NLM at a NetWare 4.x 
console, or NWCONFIG at a NetWare 5.x console, selecting License Options, then 
inserting the new license diskette in the floppy drive.
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Deploying a New Server

When you deploy a new server with an image from an existing system, you must remove 
Directory Services, then reinstall it on the deployed server to avoid conflicts with 
identical Organization and Organizational Units in existing servers, as well as to avoid 
deploying servers to different organizations with the same configuration and ADMIN 
password. You may remove Directory Services and reinstall from the server console with 
the INSTALL.NLM utility, under Directory options in NetWare. Keep in mind that to 
remove Directory Services, you must have the administrator password. 

• For NetWare 4.x, type LOAD INSTALL and press <Enter>.

• For NetWare 5.x, type NWCONFIG and press <Enter>.

1. At the server console, type the appropriate command for your version of NetWare.

2. Select Directory Options.

3. Select Remove Directory Services from this server.

4. Read the warning and press <Enter>.

5. Select Yes to confirm the removal of Directory Services.

6. Once Directory Services have been removed, return to the main Install screen.

7. Select Directory Options.

8. Select Install Directory Services to this server, and follow the prompts to reconfigure 
Directory Services for the new server.

In addition, if you deploy an imaged server to an existing tree, ensure that the Time 
Server Type correctly reflects the organization’s time synchronization configuration. If the 
imaged server was a “Single Reference” Time Server Type, and the deployed server 
participates in the same network, the Time Server Type must be changed to reflect a 
subordinate role. The Time Server Type may be changed by editing AUTOEXEC.NCF from 
the server console. See your NetWare administration documentation for more 
information about time server types.
Chapter 5:  Deploying NetWare Servers



Hardware Configurations

Because of operating system conflicts that can result from different hardware 
configurations, Server Image was not intended to copy or image a hard drive used in a 
server with different hardware configurations. While it is possible to do so, the conflicts 
that can arise from different hardware configurations may cause you to spend a 
considerable amount of time troubleshooting and eliminating hardware conflicts. If you 
find it necessary to create a server image from a specific machine and restore it to a 
system with a different configuration (for example, network interface card, IDE vs. SCSI 
drives or devices), the server may not boot correctly. You may use a DOS ASCII text 
editor to edit the STARTUP.NCF file (for example, if you need to change the disk drivers 
loaded from SCSI to IDE or vice versa) located in the C:\NWSERVER directory on the 
server’s DOS partition. Alternately, you can use EDIT.NLM, INSTALL.NLM, or 
NWCONFIG.NLM from the server console once the server is loaded to make any 
changes necessary to AUTOEXEC.NCF (for example, to change a network board driver) 
to reflect the correct hardware configuration. Due to these potential conflicts, 
PowerQuest recommends imaging and restoring servers to similar hardware 
configurations.

If you intend to deploy a server to several target machines with different hardware 
configurations, you may want to consider loading both SCSI and IDE hard disk drivers 
into the STARTUP.NCF, and multiple NIC drivers into AUTOEXEC.NCF relating to the 
hardware configurations on the target machines. If you do this in preparation for 
deployment, you can simply remove the unnecessary drivers from each machine, rather 
than installing the correct ones after deployment.

Using Hide/Unhide for Disaster Recovery

Server Image includes a hide/unhide feature that gives you the option of storing an exact 
backup of a server partition on a second hard drive without causing volume name 
conflicts. To accomplish this, it is necessary to have a server hard drive with free, 
unpartitioned hard drive space that is the same size or larger than the SYS: volume.

1. Run Server Image and create an image of the partition containing the SYS: volume. 

2. Restore that image to a second hard drive. 
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3. While in Server Image, select one of the partitions and hide it, using the 
Hide/Unhide Partition option from the Tools menu, and hide the newly made copy. 
This allows the system to have two copies of the SYS: volume, one hidden and 
inaccessible to the operating system, the other functioning normally. 

In the event of a serious server ABEND or other circumstance that corrupts the SYS: 
volume, run Server Image from the DOS partition or a floppy diskette. Select the 
hidden partition, and use the Hide/Unhide option from the Tools menu. 

Depending on your needs, the first SYS: volume may be deleted to free up space or 
hidden and kept for diagnostic or other purposes. 

With a hidden copy of a server’s SYS: volume in place on a local hard drive, down time 
from a severe server crash is virtually eliminated, and the server can be back up and 
provide services to clients within minutes. The information on the hidden SYS: volume is 
only as recent as the last time you imaged and restored the partition, so there is the 
chance that some current data will be lost.

Also, in the case when a SYS: or other partition is accidentally hidden, Server Image can 
be used to unhide the appropriate partition, so it may again be normally accessed. For 
example, if you maintain multiple copies of the DOS partition on the server hard drive, 
and alternate between them for demonstration purposes, when you use Server Image to 
set active the other partition, Server Image automatically hides all other primary 
partitions, including NetWare partitions, to avoid multiple visible primary partition 
corruption. If a SYS: volume partition is unintentionally hidden in this manner, the 
Hide/Unhide option may be used to unhide the partition.
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Interactive vs. Batch Mode

This chapter contains the following information:

Command Line Switches

Script Files



52
Server Image may be run in one of two modes: interactive (the default) or batch mode. 
Interactive mode requires user input at discrete intervals, resulting in greater control and 
efficiency when working with one or two servers. 

Alternately, batch mode is useful when loading image files onto a large number of 
servers. Batch mode automates the loading process, saving you time and effort by 
eliminating the need for repetitive user input. 

Command Line Switches

Server Image uses a series of command line switches to run in batch mode. To use the 
these switches, type PQSI /switch, where switch is one or more of the following:

Command Line 
Parameter

Description

/? Displays all available command line switches, their 
syntax, and a short description.

/IMG=<imagefilename> Designates an image file.

/CMD=<scriptfilename> Designates a script text file; the script file contains 
arguments that are passed to the program.

/LOG=<logfilename> Designates a log file.

/ERR=<errorfilename> Designates an error file.

/PWD=<password> Designates a password that must be given to restore the 
partition(s). The password may either a number or a string.

/CAS Causes all sectors within a partition to be saved and 
restored. This will include all information in a partition 
including the deleted files.

/CBS Enables bad sector checking.

/CEC Check for Extra Cylinder.

/DSK Specify disk number for macro commands.

/IFC Ignores file system checks. This allows a partition with a 
known file system error (for example, cross-linked files) to 
be stored in an image. Likewise, that same partition can 
be restored if this switch is used and if during the restore 
process the partition does not need to be resized.

/IPE Disables partition table error checking. This switch allows 
drives with partition errors to be saved and restored.
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Command Line Examples
Scenario 1: To specify SCRIPT.TXT as the script file, ERROR.TXT as the error file, and 
E:\IMAGES\DRIVE2.PQI as the image file:

PQSI /CMD=SCRIPT.TXT /ERR=ERROR.TXT /IMG=E:\IMAGES\DRIVE2.PQI

Scenario 2: To specify a syntax check for the script file SCRIPT.TXT:

PQSI /CMD=SCRIPT.TXT /SCO

/MFS=nnnnn Designates the maximum file size used for creating 
multiple files to contain a PQI image. (nnnnn is the 
number of bytes in each file).

/NBS Disables bad sector checking. By default, bad sector 
checking is disabled.

/NRB No reboot after program exit.

/RAV Causes each sector written to disk during the restore 
process to be read back and compared with the data just 
written as an extra security precaution. Using this 
parameter will significantly increase restore time.

/SCO Syntax Check Only parameter; this switch causes the 
syntax of each command in the script file to be checked 
without executing the command.

/UEB Forces the extended BIOS to be used for disk reads and 
writes.

/WFS Wipe First Sector parameter; deletes the master boot 
record once all partitions are deleted with the script 
command DELETE ALL; only accessible using scripting.

/ZLB Use ZLib compression.

Command Line 
Parameter

Description
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Script Files

The script file designated in the command line contains arguments or instructions that 
are passed to the program, determining which operations are executed. The script file 
syntax is as follows:

Script Argument Action

DELETE Deletes the last partition selected.

DELETE ALL Deletes all partitions on the drive.

DELETE EXTENDED Deletes the extended partition; the extended partition 
can only be deleted if all the logical drives within it 
have already been deleted.

HIDE Hides the last partition selected.

REBOOT Reboots the computer; any commands following this 
command will not be executed.

RESIZE IMAGE
{proportional | no | <number> | max}

Resizes the image to the specified size when restored; 
<number> is indicated in MB.

RESTORE Restores all selected images and resizes them, if 
specified.

SECTOR CHECK {on | off} Enables/Disables Bad Sector Checking for all restore 
operations following the command.

SELECT DRIVE {<number>} Selects the drive with the specified number; the first 
drive is number 1.

SELECT FREESPACE
{first | last | next | largest}

Selects the specified free space.

SELECT IMAGE {<number> | all} Selects the specified image in the image file.

SELECT PARTITION 
{<driveletter> | <volumelabel> | 
<number> | first |next | all}

Selects the specified partition(s).

SET ACTIVE Sets active the last partition selected.

STORE
{with compression {off | low | high}}

Stores all selected partitions with the indicated 
compression level.

UNHIDE Unhides the last partition selected.
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Script File Examples
Scenario 1: To store all the partitions on drive 2 to the file, E:\IMAGES\DRIVE2.PQI:

PQSI /CMD=SCRIPT.TXT /IMG=E:\IMAGES\DRIVE2.PQI

SCRIPT.TXT file contents:

SELECT DRIVE 2
SELECT PARTITION ALL
STORE

Scenario 2: To store partition 3 from drive 1, and partitions 1, 4, and 5 from drive 2 to the 
file, E:\IMAGES\DRIVES.PQI and have the image file split up into multiple files each 
650 MB so each can be transferred to a CD-ROM:

PQSI /CMD=SCRIPT.TXT /IMG=E:\IMAGES\DRIVES.PQI /MFS=650000000

SCRIPT.TXT file contents:

SELECT DRIVE 1
SELECT PARTITION 3
STORE
SELECT DRIVE 2
SELECT PARTITION 1
SELECT PARTITION 4
SELECT PARTITION 5
STORE

Scenario 3: To restore all the images in the file, E:\IMAGES\DRIVES.PQI, to the first free 
space on drive 2:

PQSI /CMD=SCRIPT.TXT /IMG=E:\IMAGES\DRIVES.PQI

SCRIPT.TXT file contents:

SELECT DRIVE 2
SELECT FREESPACE FIRST
SELECT IMAGE ALL
RESTORE

Scenario 4: To restore the first two images in the file, E:\IMAGES\DRIVES.PQI, to the 
largest free space on drive 1, and resize them both proportionally:

PQSI /CMD=SCRIPT.TXT /IMG=E:\IMAGES\DRIVES.PQI

SCRIPT.TXT file contents:

SELECT DRIVE 1
SELECT FREESPACE LARGEST
SELECT IMAGE 1
SELECT IMAGE 2
RESIZE IMAGE PROPORTIONAL
RESTORE
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Scenario 5: To restore the first two images in the file, E:\IMAGES\DRIVES.PQI, to the last 
free space on drive 1, and resize them to 500 MB each (The image was encrypted using 
the password 12345678):

PQSI /CMD=SCRIPT.TXT /IMG=E:\IMAGES\DRIVES.PQI /PWD=12345678

SCRIPT.TXT file contents:

SELECT DRIVE 1
SELECT FREESPACE LAST
SELECT IMAGE 1
RESIZE IMAGE 500
SELECT IMAGE 2
RESIZE IMAGE 500
RESTORE

Scenario 6: To delete all existing partitions on drive 2 and then restore all the images in 
file, E:\IMAGES\DRIVES.PQI, to the free space (The image was encrypted using the 
password HELLO):

PQSI /CMD=SCRIPT.TXT /IMG=E:\IMAGES\DRIVES.PQI /PWD=HELLO

SCRIPT.TXT file contents:

SELECT DRIVE 2
DELETE ALL
SELECT FREESPACE FIRST
SELECT IMAGE ALL
RESTORE

Scenario 7: To restore the first four images in the file, drive:\IMAGES\DRIVES.PQI, to the 
last free space on drive 1, and then resize the first image to 500 MB, keep the second the 
same size, and resize the third and fourth images to proportionally take up the remaining 
free space:

PQSI /CMD=SCRIPT.TXT /IMG= drive: \IMAGES\DRIVES.PQI

SCRIPT.TXT file contents:

SELECT DRIVE 1
SELECT FREESPACE LAST
SELECT IMAGE 1
RESIZE IMAGE 500
SELECT IMAGE 2
RESIZE IMAGE NO
SELECT IMAGE 3
SELECT IMAGE 4
RESIZE IMAGE PROPORTIONAL
RESTORE

NOTE:  For further scenarios, visit our home page at http://www.powerquest.com.
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Hard Drive Manufacturer Contact Information

To find the jumper settings for hard drives, consult your hard drive installation guide, or 
contact your hard drive manufacturer directly. This section contains the World Wide Web 
site addresses and phone numbers for the most common hard drive manufacturers. In 
most cases, the hard drive manufacturer's web site contains the information you need to 
install the hard drive correctly.

Another valuable resource is the web page, http://blue-planet.com/tech/index.html. In 
addition to listing the most common hard drive manufacturers, this site provides the 
jumper settings for every hard drive ever made.

Additional jumper information is available from OnTrack at http://www.ontrack.com.

Contact Information

NOTE:  The following contact information was correct at the time this manual was printed. 
Information is subject to change.

Fujitsu 

• URL: http://www.fcpa.com/support/su_support_frame.html

• Tech Support Phone: 800-626-4686

• Fax Back Support: 408-428-0456

Maxtor

• URL: http://www.maxtor.com/satisfaction/contact.html

• Tech Support Phone: 800-2-Maxtor or 800-262-9867

• Tech Support Fax: 303-260-2260 or 408-922-2050

• E-mail: Technical_Assistance@Maxtor.com

Quantum

• URL: http://support.quantum.com/

• Tech Support Phone: 800-826-8022

• Fax Back Support: 800-434-7532
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Samsung Electronics America

• URL: http://samsungelectronics.com/support/faqs/index.html

• Tech Support Phone: 800-726-7864

• Fax Back Support: 800-229-2239

Seagate/Conner

• URL: http://www.seagate.com/support/disc/specs/qickspec.shtml

• Tech Support Phone: 408-456-4496 

• Tech Support Fax: 405-936-1685

• Fax Back Support: 405-936-1600

• Automated Support: 800-732-4283

Western Digital

• URL: http://www.wdc.com/support

• Tech Support Phone: 800-275-4932

• Fax Back Support: 714-932-4300
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Using FDISK and FORMAT to Create and 
Format Partitions

NOTE:  Although FDISK and FORMAT do not offer the functionality and flexibility of 
PowerQuest’s ServerMagic, these free utilities are capable of creating new FAT 
partitions or deleting existing partitions.

This section explains how to create and delete partitions for the following situations:

Scenario 1:
If you copied a single FAT partition (C: drive) from your source hard drive to a destination 
hard drive larger than 2.1 GB, you now have unallocated disk space and need to create a 
partition(s). To create and format a partition(s) using FDISK and FORMAT:

NOTE:  Using FDISK to create partitions from unallocated disk space is simple and does 
NOT destroy any existing data on the hard drive. FDISK, however, does NOT allow 
you to change partition sizes without destroying data.

1. At a DOS or MS-DOS prompt, type FDISK and press <Enter>.

2. Select 1 to Create DOS partition or Logical DOS Drive and press <Enter>.

3. Select 2 to Create Extended DOS partition and press <Enter>.

4. Press <Enter> again to create the Extended DOS partition.

5. Press <Esc>.

6. Press <Enter> to create the Logical DOS Drive within the Extended partition.

7. If your hard drive is larger than 4 GB, you can create a second Logical DOS partition 
with the remaining disk space. To do so press <Enter>.

8. Press <Esc> twice to return to a DOS or MS-DOS prompt.

NOTE:  To format your new partitions, type FORMAT drive: at a DOS or MS-DOS 
prompt where drive is the drive letter of the new partition. You now have 
additional partitions on your destination hard drive (example D:, E:).
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Scenario 2:
If you want to leave your source drive in as a secondary or Slave drive after the copy, you 
need to delete and recreate partitions so that drive letters do not conflict. To delete and 
recreate partitions on your source hard drive after the copy process is finished, follow 
these steps:

NOTE:  This process will delete the data on this hard drive; however, you have a complete 
copy on your destination drive.

1. If you have not already done so, change the jumper settings on the original source 
drive to reflect a secondary or Slave setting in a two drive system. Then switch the 
jumper settings on the destination drive to reflect a primary or Master setting in a two 
drive system.

2. At a DOS or MS-DOS prompt, type FDISK and press <Enter>.

NOTE:  If you are asked whether you wish to enable large disk support, click YES and 
press <Enter> UNLESS you plan on using other operating systems on your PC, 
including some versions of Windows 95 and Windows NT, as well as earlier 
versions of Windows and MS-DOS.

3. Select 5 to Change Current Fixed Disk Drive and press <Enter>.

4. At the Change Current Disk Drive Screen, choose 2 to change to your second disk 
drive and press <Enter>.

5. Next select 3 to Delete partition or Logical DOS drive and press <Enter>.

6. Choose to delete your logical drive(s) first and then your extended partition and then 
finally your primary partition(s). Or if you only have one partition on your source 
hard drive choose to delete the single primary partition.

7. Select 1 to Create DOS partition or Logical DOS Drive and press <Enter>.

8. Next select 2 to Create Extended DOS partition and press <Enter>.

9. Press <Enter> again to create the Extended DOS partition.

10. Press <Esc>. 

11. Press <Enter> to create the Logical DOS Drive within the Extended partition.

12. If your hard drive is larger than 4 GB, you can create a second Logical DOS partition 
with the remaining disk space. To do so press <Enter>.
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13. Press the <Esc> key twice to return to a DOS or MS-DOS prompt.

14. To format your new partitions, type FORMAT drive: at a DOS or MS-DOS prompt 
where drive is the drive letter of the new partition.

You now have a new empty partition(s) in which to store your applications and data.

Using Server Image with SCSI Hard Drives

To use Server Image on a SCSI hard drive, you must have a SCSI controller card that 
supports software Interrupt 13. Most SCSI controller cards let the user enable software 
Interrupt 13 support in the BIOS through the card. If your SCSI controller card does not 
allow you to set it to use software Interrupt 13, Server Image will not work on drives 
attached to your SCSI adapter. Contact the manufacturer of the SCSI adapter to determine 
if your adapter can support software Interrupt 13. As a general rule, if FDISK can be used 
to partition the drive, you can use Server Image.

Assigning a CD-ROM Drive Letter

If your computer has a CD-ROM drive or any form of removable media, you should be 
aware of potential problems with the way drive letters are assigned to these devices.

Server Image does not make drive letter assignments; this is a function of the operating 
system. The operating system assigns drive letters in the following order: The first 
recognized primary partition on each hard drive will receive a letter, followed by all 
logical partitions on each hard drive. Next, the CD-ROM drive and any other form of 
removable media will be assigned a letter.

Because the CD-ROM is one of the last drives to receive a letter, any partitions that you 
create or delete on any of your hard drives will affect the drive letter assignment of your 
CD-ROM drive. This change in drive letter assignments is usually performed by the 
operating system automatically. Occasionally, however, the operating system will fail to 
assign a new drive letter to the CD-ROM drive. If this should occur, please follow the 
steps listed below.
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If you are using DOS/Windows 3.11 or are loading your CD-ROM drivers under DOS 
with Windows 95:

1. At a DOS prompt, type EDIT C:\CONFIG.SYS.

This starts the DOS editor program and opens your CONFIG.SYS file. 

2. Change LASTDRIVE=drive (in which drive is any letter of the alphabet) to Z.

This allows the OS to assign all drive letters through Z.

3. Click File > Exit.

4. Click Yes to save the file.

5. You should now be back to a C:\ prompt. Type EDIT C:\AUTOEXEC.BAT.

The DOS editor program starts and opens your AUTOEXEC.BAT file. 

6. Look for a line that includes the word MSCDEX. The /L:drive parameter (in which 
drive is the drive letter that was assigned to your CD-ROM before you made changes 
with Server Image) may appear at the end of this line. Change this letter to U. 

Because the OS assigns all other available drive letters before assigning Z:, this 
ensures that partition changes you make in the future will not invalidate your 
CD-ROM drive letter. 

For more information, type HELP MSCDEX at a DOS prompt.

NOTE:  If your computer is on a network when you log in to the network, the letter Z 
and other letters at the end of the alphabet may be assigned to network search 
drives. In this case, assign your CD-ROM a letter just before the first letter used 
by the network search drives.

7. Select File, then Exit. When you are asked whether you want to save the file, click 
Yes.

8. When you see the DOS prompt (C:\), reboot your machine.
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Troubleshooting

This appendix gives solutions to problems that you may encounter while using 
PowerQuest's Server Image. Included are the following:

Frequently Asked Questions

Freeing Memory to Run Server Image

Resolving Partition Table Errors

Partition Tables and Viruses
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Frequently Asked Questions

PowerQuest maintains the latest Frequently Asked Questions at 
http://support.powerquest.com/FAQS.html

Freeing Memory to Run Server Image

The Server Image executable running under DOS requires a minimum of 400KB of 
memory in the first 640KB of the computer's address space (conventional memory). If 
you try to run Server Image from DOS, and find you do not have enough free 
conventional memory, you can free enough additional memory in a number of ways.

Running MEMMAKER
MEMMAKER is a program that automatically configures your computer to save 
conventional memory (while still loading all of the device drivers and other programs 
you usually load when booting DOS). MEMMAKER frees conventional memory by 
moving as many programs as possible out of conventional memory into high memory. 
Run MEMMAKER by typing MEMMAKER at a DOS prompt. Follow the on-screen 
instructions.

NOTE:  MEMMAKER is only available with DOS versions prior to DOS 6.0. 

Using the F8 Key to Keep Programs From Loading
If running MEMMAKER does not free enough conventional memory, you can free more 
by pressing <F8> right after booting your computer (while DOS is booting). If you press 
<F8>, when DOS reads the commands from the CONFIG.SYS and AUTOEXEC.BAT files 
on your hard drive, DOS asks you if you want it to execute each command. When you 
see commands that load device drivers or TSR programs that you do not need to run 
Server Image, answer N (no) to tell DOS not to execute that command (not load that 
software into memory). This conserves conventional memory. 
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Creating an Operating System Boot Diskette
If running MEMMAKER and using <F8> does not free enough conventional memory, you 
can create a boot diskette that allows you to boot using a very minimal amount of 
conventional memory.

To create a boot diskette for any version of DOS:

1. Place in your diskette drive (A:) any diskette that does not contain information you 
want to keep. 

2. Go to a DOS prompt, type FORMAT drive: /S (where drive is the drive letter of the 
diskette drive).

3. Press <Enter>.

After the diskette is formatted and the operating system files are transferred, you can boot 
the computer from the diskette. If you restart your computer with the diskette in the 
diskette drive, your computer boots using a minimal amount of conventional memory. 
After you boot from the diskette, you can run Server Image from either the diskette or 
your hard drive.

Creating a CONFIG.SYS File on the Boot Diskette
If making an ordinary boot diskette doesn't free enough conventional memory, you can 
create a customized boot diskette that frees even more conventional memory. (With the 
customized diskette, you free more conventional memory by loading some of the DOS 
operating system into high memory.) To customize the diskette, you must create a 
CONFIG.SYS in the root directory. 

To create a CONFIG.SYS in the root directory:

1. Go to a DOS prompt. 

2. Type drive: (where drive is the drive letter of the diskette drive) and press <Enter>. 

NOTE:  Verify that you have changed to the diskette drive (you see the drive:\> 
prompt).

3. Type EDIT CONFIG.SYS and press <Enter>. 

NOTE:  This starts the DOS editor (you will see a blank screen).
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4. In the editor, type the following:

DEVICE=C:\DOS\HIMEM.SYS

DEVICE=EMM386.EXE

DOS=HIGH,UMB

NOTE:  All lines must be entered in the order shown. Windows users: Substitute 
WINDOWS for DOS.

5. Click File > Save to save the file. 

6. Click File > Exit to exit the editor.

You can now reboot your computer from the customized boot diskette. When DOS loads, 
much of it is loaded into high memory, saving a maximum amount of conventional 
memory.

Deleting Operating System Compression Files
If you use DOS 6.22 and your system doesn't have any compressed drives (for example, 
DriveSpace, DoubleSpace, or Stacker), you can delete the operating system compression 
files DRVSPACE.BIN or DBLSPACE.BIN from any boot diskette you create. This frees 
more conventional memory, because DOS 6.22 loads the contents of these files into 
memory, regardless of what's in the CONFIG.SYS or AUTOEXEC.BAT. To delete these 
hidden system files:

1. From the DOS prompt, type drive: (where drive is the drive letter of the diskette 
drive).

2. Type ATTRIB -R -H -S *.BIN.

3. Type DEL *.BIN.
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Resolving Partition Table Errors

To resolve partition table errors, you must create new, error-free partition tables.

NOTE:  In some cases, PowerQuest technical support can help you fix partition table errors 
without data loss. Check with them first before proceeding to the following steps.

To create new partition tables:

1. Make sure you have no viruses. 

NOTE:  See “Partition Tables and Viruses” (page 70).

2. Back up the data on the affected partitions.

3. Delete the partitions.

NOTE:  You may need to use the FDISK program from a recent DOS version, because 
earlier versions of DOS may refuse to delete HPFS or hidden partitions.

If using OS/2, the OS/2 FDISK program may recognize the partition's corruption 
and refuse to modify it. In this case, use the FDISK program from a recent DOS 
version.

4. Recreate the partitions.

5. Restore the contents of the partitions. 
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Partition Tables and Viruses

If partition changes made under one operating system are not reflected under the other, 
and vice versa, it is possible that a master boot record (MBR) virus is present.

Use a virus check utility that can detect the latest viruses. If a virus is found, data loss is 
likely. To eliminate a virus:

1. Before removing the virus, run ScanDisk or CHKDSK under each of the operating 
systems to evaluate the integrity of the partition. 

2. Back up the files from any partition that passes the Check operation.

3. After backing up the files from all operating systems, remove the virus.

4. Run ScanDisk or CHKDSK under each of the operating systems again.

5. Delete and recreate any partitions that fail the check. 

6. Reinstall the operating system(s).

7. Restore the backup files as necessary.
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Before You Contact Technical Support

PowerQuest is committed to providing you with comprehensive technical support. 
However, before calling our technical support department, try to resolve your problem 
by using this guide, the online Help system, or check PowerQuest's Web site for 
Frequently Asked Questions at http://support.powerquest.com/FAQS.html, or for 
international customers, see http://www.powerquest.com/intnl/index.html. Also, check 
the README.TXT file for information that has changed since this guide was printed.
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PowerQuest Problem Report

If you cannot find the solutions you need in this guide, please have the following 
information ready or send it along when you contact technical support:

Your Company Name ________________________________________________________________

Your Name _________________________________________________________________________

Your Phone Number _________________________________________________________________

Your Fax Number ____________________________________________________________________

ServerMagic Serial Number ___________________________________________________________

Computer Manufacturer ______________________________________________________________

Computer Model and Model Number ___________________________________________________

Date of Computer Manufacture ________________________________________________________

Processor Type (386, 486, Pentium) ________________________________________________________

Amount of Memory (RAM) ____________________________________________________________

Operating System(s) / Version Number (NetWare 5, etc.) ______________________________________________  

File System(s) (FAT, FAT32, HPFS, etc.) ______________________________________________________

Other Hardware. Include bus type (ISA, EISA, MCA, PCI, VESA), hard drive model, and external drives.

____________________________________________________________________________________

Memory Resident Software. Include memory managers and list their version numbers (for example, 

OnTrack’s Disk Manager Version 6.0 or EZ-Drive Version 7.0).

____________________________________________________________________________________

____________________________________________________________________________________
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Contacting PowerQuest Technical Support

If you cannot get the help you need from this guide, you can contact our technical 
support department in any of the ways listed below. You must be a registered Server 
Image user to receive the following types of technical support. PowerQuest offers free 
support for 45 days from the date of your first call to PowerQuest’s technical support.

Fax

Fax the information listed on the pages above and a description of your problem to the 
technical support fax number. This service is available in the U.S., Canada, and Europe 
24 hours a day, 7 days a week. We try to respond to all fax requests within 24 hours.

Faxback

Postal Service Mail

Please include the information from the PowerQuest Problem report with a description 
of your problem. Be sure to also include a return address, a daytime phone number, or 
other relevant contact information.

Corporate Web Site 
http://www.powerquest.com

Location Number

USA (801) 437-4218

Europe (+31) 20 582 9260

Location Number

USA (801) 437-7921

USA Toll Free (800) 720-0391

USA Europe

PowerQuest Corporation

PO Box 1911

Orem, Utah 84059-1911

PowerQuest

Orlyplein 85

1043 DS

Amsterdam

The Netherlands
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E-mail

Please include the information from the PowerQuest Problem Report with a description 
of your problem in your e-mail message.

Telephone

Our USA call center is open Monday through Friday, 7 a.m. to 6 p.m., MST/MDT. Our 
European call centers are open Monday through Friday, 9:00 to 18:00 CET. Please have 
the information from the PowerQuest Problem report ready for the technical support 
technician.

Language Location E-mail

English USA support@powerquest.com

Italian USA italian@powerquest.com

Portuguese USA latina@powerquest.com

Spanish USA spanish@powerquest.com

Dutch Netherlands eurots@powerquest.com

English Netherlands eurots@powerquest.com

English UK eurots@powerquest.com

French France france@powerquest.com

German Germany germany@powerquest.com

Language Location Number

Dutch Netherlands (+31) 20 581 3906

English Netherlands (+31) 20 581 3907

English UK (+44) 0171 341 55 17

English USA (801) 226-6834

French France (+33) 1 69 32 49 30

German Germany (+49) 069 66 568 516

Italian Italy (+39) 02 45 28 1312

Portuguese USA (801) 226-6834

Spanish Spain (+34) 91 622 3146

Spanish USA (801) 226-6834
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PowerQuest Newsletter and Internet Address

PowerQuest has a monthly electronic newsletter that is dedicated to official 
announcements regarding PowerQuest products. It also contains tips and techniques for 
getting the most out of your PowerQuest products. Signing up on the list will give you all 
the information you need regarding product tips, bugs, and patches. Just go to the 
PowerQuest home page (http://www.powerquest.com), enter your email address in the 
space provided, then click Subscribe.

You will be e-mailed a response verifying your subscription.
Appendix C:  PowerQuest Technical Support



Glossary

ATA
A standard used by hard drives to communicate with the controller ports or cards that allow the 
hard drive to interface with the computer. Before ATA, there were numerous incompatible 
methods for interfacing hard drives to computers. ATA simplifies this process, thus reducing the 
cost of developing and purchasing related hardware. ATA is the proper term for Integrated Drive 
Electronics (IDE).

ATA-2
ATA-2 is the common name for a new, enhanced IDE standard. This standard is still evolving and 
has not yet been submitted for approval as an official standard.

Batch Mode
Switches in a normally interactive program that prepare it to receive non-interactive command 
input.

BIOS (Basic Input/Output System)
The BIOS is the program code stored in a PC-compatible ROM to boot the computer and provide 
basic services such as low-level hard drive access.

Cloning 
Copying a hard drive to an image file or destination disk to create an exact duplicate.

Destination
The destination hard drive is the drive that is copied to during a restore operation.

Disk
A hardware device to store data. A disk contains a Master Boot Record and partitions.

EIDE (Enhanced Integrated Drive Electronics)
A marketing program that promotes certain features of ATA-2.

Extended Partition
One of the four primary partitions on a hard drive can be an extended partition. Extended 
partitions do not directly hold data; rather, you can create an unlimited number of logical 
partitions within the extended partition to store data. An extended partition cannot be the active 
partition.
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FAT File Allocation Table
File system used by DOS, Windows 95, NT and sometimes OS/2 to store and retrieve 
files and directories.

FAT32
FAT32 is the file system used by updated versions of Windows 95 (version 4.00.950B or 
above) and Windows 98. FAT32 is an enhancement of the FAT file system and is based 
on 32-bit file allocation table entries, rather than on the 16-bit entries the FAT file system 
uses. As a result, FAT32 supports much larger volumes (up to 2 terabytes).

GB (Gigabyte)
1,073,741,824 bytes.

IDE
See ATA.

Image
An image is a snapshot of a drive’s partition(s) that can be used to back up a system, 
install a new hard drive, or configure a new system.

Jumper 
Metal prongs and a circuit completion cap on the outside of a hard drive. You can 
remove, reposition, and then replace the cap to create various jumper settings such as 
Master and Slave.

HPFS
High Performance File System an alternative to a FAT file system which is used by OS/2.

Interactive Mode
An operation mode where the program's responses alternate with user commands, each 
being dependent upon the other.

LBA (Logical Block Addressing)
1) In EIDE, a means of specifying sector addresses by replacing CHS values with a single 
linear 28-bit number. 2) Generically, a one-dimensional address of a hard-disk sector, 
contrast with CHS.

Linux
Linux Ext2 file system was developed for the Linux operating system (a free-ware version 
of the UNIX operating system). Linux Ext2 file system supports a maximum volume size 
of 4 terabytes.
Glossary



Logical Drive
A contiguous area inside an extended partition that can be used by the operating system 
to store and retrieve files.

Master 
The first hard drive on an IDE hard drive controller.

MB (Megabyte)
1,048,576 bytes.

NetBIOS
A high level Network programming interface which is supported by lower level Network 
protocols such as IP/SP and TCP/IP.

NetWare
The Novell NetWare network operating system uses the NetWare File System, which was 
developed specifically for use by NetWare servers.

NTFS New Technology File System. 
An alternative to FAT and HPFS file systems used by WinNT.

Partition
An uninterrupted area on a disk, defined in the Master Boot Record. Every partition 
contains a specific file system such as FAT, FAT32, HPFS, or NTFS.

Primary Partition
A partition referenced in the Master Boot Record partition table. Four primary partitions 
can exist on a hard drive. One of these may be an extended partition. Only one primary 
partition on a drive may be active at time. Data and applications are often placed on a 
logical partition inside an extended partition. This enables the data to be accessed by all 
primary partitions.

Restore
Downloading an image file to a destination drive. 

Slave
The second hard drive on an IDE hard drive controller.

Script File
A series of instructions, usually in text file format, written to be passed to a program 
running in batch mode. 
Glossary 79
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Source
The Source hard drive is the drive from which the image is made.

Volume
This User Guide uses the term volume interchangeably with partition.
Glossary
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